
Chapter 2 

Working with Employee Reminders 
This chapter explains how to view, schedule, and manage group and individual employee reminders. In this 
chapter, the following topics should help you set up and maintain your district’s employee reminders: 

• 
• 
• 
• 
• 
• 
• 
• 
• 

• 
• 
• 

Understanding the Reminders Search Screen

Understanding the Reminders Search Screen 

 
Scheduling Reminders for Groups of Employees 
Viewing an Employee’s Reminders 
Searching and Sorting an Employee’s Reminders 
Scheduling a Reminder for an Employee 
Editing Employee Reminders 
Generating and Printing Reminder Reports 
Deleting Reminders 
Automatic Features of T.O.M. Employee Reminders 

When you open the Employee Management system, the first thing you will see the default view of the 
Reminders tab ( ). This tab displays today’s date, the number of records found, and all employees 
who have reminders for tasks that are past due or due within the warning period. This ensures that all 
important reminders are communicated to you as soon as possible. 

Figure 2-1

The Reminders search screen consists of these subtabs: 

Due Now Subtab

Due Now Subtab 

 
Other Options Subtab 
Sorting Subtab 

The Due Now subtab on the Reminders search screen is the first screen you see when you launch the 
Employee Management system.  

The Employee Management system tracks reminders and lets you know when you launch the system which 
ones are due within the warning period to ensure that all important reminders are communicated to you as 
soon as possible. The warning period is the number of days before a particular task’s due date that you 
wish to be alerted of an impending reminder. 

Notice that there are several Category and Reminder types in the graphic below. For example, you can see 
that the Training Category has several Reminder types associated with it: CPR, Refresher, and First Aid. 
When you add category and reminder types to the Employee Management system, you can specify their 
warning period. For example, you might specify that you want to be notified 15 days prior to the due date 
of a CPR training course.  
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NOTE: You can learn more about adding Category and Reminder types in Chapter 5 of the Getting 
Started section. 

 

Today’s date

Number of 
records found 

 
 

 

Figure 2-1. Due Now subtab of the Reminder search screen 

Other Options Subtab 

When you click the Other Options tab on the Reminders screen ( ), you can select addi
search options. For example, you can search for reminders with a particular status (such as just O
a specific category or type. You can also combine these options with general employee search op
that you can view the employee reminder records using a status, category, and type. 

Figure 2-2

NOTE: You can also change the way you view reminder records by combining an employee se
this screen. See Combining Reminder Search Options with Employee Search Options for more
information about this feature. 

2-2  T.O.M. Employee M
Employee 
reminders that
are due within
the warning 
period 
Tabs you can
use to search 
and sort 
employee 
reminder 
records 
tional 
verdue) or 
tions so 

arch with 
 

anagement  



 
Chapter 2: Working with Employee Reminder Records 

 Status 
options 

 

Figure 2-2. Other Options subtab 

You can select the following options to search reminder records: 

Overdue. Allows you to view employee reminder records that are past their due date. • 
• 

• 

• 

• 

• 

All Pending. Allow s you to view all employee reminder records that have not been marked
complete. 
All. Allows you to view all employee reminder records in the database, including those that
been marked completed. 
Due within X (days). Allows you to view the records that are due within the number of day
specify by typing in the value or by clicking the up and down areas to change the displayed 
Reminder Category. Allows you to select the reminder category you want to view. Default
options include Training and Evaluation. 
Reminder Type. Allows you to select the reminder type you want to view. Default options 
include Annual and BTW (Behind the Wheel Training). 

NOTE: You can add categories and tasks to the Employee Management system by selecting 
File>Reminders. This is discussed in Chapter 5 of the Getting Started section. 

 

 T.O.M Tip 

What if I pick the wrong viewing options or the results aren’t what I expected

If you select the wrong category or type before you click the Find Now button, you
select the blank option, which is the first row, in the appropriate pull-down menu t
reset those fields.  

If the results are not what you expected after you click the Find Now button, you c
start over by clicking the Reset button to clear your selections and the employee 
reminder records. Then, click Find Now to repopulate the screen. 
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To search for reminders: 

1. Click the Other Options subtab on the Reminders screen ( ). The Employee Management 
system displays the Other Options screen. 

Figure 2-3

Figure 2-3. Other Options subtab 

 

Click here to 
display 
search 
options. 

2. Select  the options you want to use to search the reminders. 

 

 T.O.M Tip 

Do I have to complete the entire screen? 

No. You do not need to complete all the fields on the Reminders tab to search reminder 
records. In fact, if you want to view all employees who have reminders, you can leave 
all the fields blank and then click the Find Now button.  

I completed the screen, but nothing happened. What’s wrong? 

If this happens, click Reset. This clears any other criteria you might have selected on 
other screens. Then, select your absence criteria again, and click Find Now.  

 

3. Click the Find Now button. The Employee Management system uses your selections to search 
reminders and displays the results. 

4. Look at the screen to see how many records are displayed ( ).  Figure 2-4
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Look here to 
see how many 
records are 
displayed. 

Results of 
searching 
for training 
reminders 
that are 
overdue. 

 

Figure 2-4. Results of searching reminder recordss 

Sorting Subtab 

To make the employee reminders more useful to view, print, or generate reports from, you can sort them by 
various fields. You can select up to three of these options as your sort criteria. Also, after you select a sort 
option, you can select ascending or descending as the sort order. 

 

 T.O.M Tip 

At what point can I sort employee reminder records? 

You can sort employee reminder records at any point. When you sort employee 
reminder records, you are sorting displayed records, even if you are only viewing only a 
few records from your database.  

What if I pick the wrong sorting options or the results aren’t what I expected? 

If the results are not what you expected after you click the Find Now button, you can 
start over by clicking the Reset button to clear your selections and the employee 
reminder records. Then, click Find Now to repopulate the screen.  

However, if you have searched the records and click Reset and then Find Now, the 
records displayed are the same as those that displayed when you last started the system. 

To sort employee reminder records: 

1. Click Sorting on the Reminders screen ( ). The Employee Management system displays the 
sorting options. 

Figure 2-5
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Click here to 
display sorting 
options. 

Figure 2-5. Sorting subtab 

2. Select sorting criteria and order options by clicking the pull-down menus and selecting options in the 
pull-down lists. You can sort the data up to three times ( ). Figure 2-6

 

 

2-6 
You can select
various fields 
as your sort 
criteria and 
Ascending and
Descending as 
the sort order. 
Figure 2-6. Selecting employee reminder sorting options 
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3. Click the Find Now button to retrieve the selected employee reminder records and sort them in the 
desired order. The Employee Manager system updates the displayed records in the specified sort order. 

 shows the results of sorting reminders by category and then by type: Figure 2-7

Figure 2-7. Results of sorting reminders 

 

Combining Reminder Search Options with Employee Search Options 

In addition to searching reminders by clicking on the Other Options subtab, you can also search for 
employees who have reminders associated with them. For example, you could search for all employees 
with an employee type of Driver who have a training reminder associated with them. 

To combine reminder search options with employee search options: 

1. Click the Employees tab. The Employee Management system displays the Employees screen. 

2. Click the Reset button to clear the screen. The Employee Management system clears the screen. 

3. Select the criteria you want to use to search for employees.   shows selecting the Employee 
Type of Driver for the search criteria. 

Figure 2-8
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Click Reset to 
clear the 
screen. 

Figure 2-8. Selecting Driver as the Employee Type 

4. Select the Reminders tab. 

5. Select the criteria you want to use to search for reminders.  shows selecting the Reminder 
Type of Training for the search criteria. 

Figure 2-9

Figure 2-9. Selecting Training as the Reminder Type 
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6. Click the Find Now button. The Employee Management system uses the selected criteria to search 
employee records displayed on the Employees tab.  

Figure 2-10

Figure 2-10. Results of combining reminder search options with employee search options 

 shows the results of searching for  employees who are classified as drivers AND who 
have a training reminder associated with them: 

 

Scheduling Reminders for Groups of Employees 
Although you can set up reminders for individual employees as described later in this chapter, it is far more 
efficient to set up reminders for an entire group of employees. This not only saves time, but it reduces input 
errors that might occur from entering so many separate reminders.  

Even though you are setting up a group reminder, you can customize the due date for each employee. For 
example, one of the set up options allows you to select the employee’s birthday as the due date. Suppose 
you manage the data for 400 employees. If you select Next birthday as your reminder date option, you are 
creating one reminder that is customized for all employees because it is associated with their birthday. 

This section consists of the following: 

• 
• 
• 

Adding a Group Reminder for All Employees

Adding a Group Reminder for All Employees 

 
Adding a Group Reminder for a Selected Group of Employees 
Understanding the Group Reminder Screen 

1. Click the Employees tab. The Employee Management system displays the Employees screen. 
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2. Click the Reset button to clear the screen. The Employee Management system clears the screen 
( ). Figure 2-11

Figure 2-11. Clearing the Employee screen 

Click Reset to 
clear the 
screen. 

Click Find 
Now to search 
for and retrieve 
records. 

Click Group 
Training to add 
a group 
reminder to the 
system. 

 

3. Click the Find Now button to retrieve all the employee records in the database. 

4. Click the Group Reminder button. The Employee Management system displays the Schedule 
Reminder/Task screen.  

5. Select options from the drop-down lists or type information into the fields. See the detailed discussion 
of the various fields in the Group Reminder screen later in this chapter for more information. 

NOTE: You must select a Category, Type, and Due Date (such as Next Birthday). These are required 
fields. If you click the Schedule Now button before you complete these fields, the Employee 
Management system displays a warning. 

6. Click the Add All button to add all employees to the group request. 

Figure 2-12 shows adding a training reminder on the next birthday of all employees. 
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Category, 
Type, and Due 
Date are 
required fields.  

Example 
showing that 
all employees 
have been 
added to the 
group 
reminder. 

Figure 2-12. Adding all available employees to a group reminder 

7. Click the Schedule Now button to add the reminder to the database. The Employee Management 
system displays a progress bar at the bottom of the screen to indicate it is adding the reminder to the 
database. When it is finished, you will see a dialog indicated that this process is complete. 

Adding a Group Reminder for a Selected Group of Employees 

In addition to customizing the due dates for group reminders, you can create group reminders for selected 
groups of employees that you want to include in the reminder. The Group Reminder screen fills in the 
Available Employees list with those employees found in your employee search. From this list, you can 
either select all of the found employees or further refine the list of employees to build the reminder for by 
individually adding them to the Selected Employees list. For example, you can search employee records to 
display all the drivers in your database. You could then add all the drivers to the group reminder, or you 
could select only certain drivers for inclusion in the group reminder. 

NOTE: You must add at least one employee to the reminder. If you do not, the Employee Management 
system displays a message if you click the Schedule Now button. 

 

 T.O.M Tip 

What if I added the wrong employees to a reminder? 

If you have not added the task to the database, you can click Reset List or click the 
Remove All button  to remove all employee names from the Selected Employees box. 
To remove only some employees from the Selected Employees box, select their names, 
and click the Remove button. 

 

To create a group reminder for a group employees: 

1. Click the Employees tab. The Employee Management system displays the Employees screen. 
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2. Click the Reset button to clear the screen. The Employee Management system clears the screen. 

3. Select the fields you want to use to select employee records.  shows selecting Driver from 
the Employee Type drop-down list on the Employees search screen. 

Figure 2-13

Figure 2-13. Example of selecting Employee search options 

 

4. Click the Group Reminder button. The Employee Management system displays the Schedule 
Reminder/Task screen.  

5. Select options from the drop-down lists or type information into the fields. 

NOTE: You must select a Category, Type, and Due Date (such as Next Birthday). These are required 
fields. If you click the Schedule Now button before you complete these fields, the Employee 
Management system displays a warning. 

6. To add employees to the group reminder: 

Select an employee’s name, and then click the Add button. • 
• 

• 

Select an employee’s name, hold down your Shift key, and click another employee’s name to 
select a range of names. Then, click Add. 

OR 
Select an employee’s name, hold down your Ctrl key, and select another employee’s name. 
Continue this process until you have selected all the employees you want to include in the 
reminder. Click Add ( ). Figure 2-14
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Example 
showing 
selected 
employees 
have been 
added to the 
group 
reminder. 

 

Figure 2-14. Adding selected available employees to a group reminder 

7. Click the Schedule Now button to add the reminder to the database. The Employee Management 
system displays a progress bar at the bottom of the screen to indicate it is adding the reminder to the 
database. When it is finished, you will see a dialog indicated that this process is complete. 

Understanding the Group Reminder Screen 

The Employee Management software allows you to setup both Reminder Categories and Reminder Types. 
These two reminder classifications are interrelated to each other. Reminder Category is the broad reminder 
classification, and Reminder Type is a subset of the reminder category. For example, you could have a 
Reminder Category of Training and three Reminder Types, or reminder subsets, attached to that category 
(Behind the Wheel, Classroom, and Other).  

Consequently, the Employee Management software doesn’t allow you to specify a Reminder Type until 
you have selected a Reminder Category. After you have selected the Reminder Category, the Employee 
Management system dynamically builds a list of Reminder Types that are assigned to the selected 
Reminder Category and lets you pick from those types. Using the example above, if you pick Training as 
the Reminder Category, the Employee Management system displays Behind the Wheel, Classroom, and 
Other as the Reminder Types. 

Category. Allows you to specify the reminder category. When you select an option from the pull-
down menu, the Employee Management system populates the Type pull-down menu with the 
reminder types associated with the selected category. 

• 

• Type. Displays the reminder types that are available for the selected Category. 

NOTE: You can add categories and tasks to the Employee Management system by selecting 
File>Reminders. This is discussed in Chapter 5 of the Getting Started section. 
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Due Date. The reminder’s due date may be one of the following four types: • 

• 

1. Next birthday. Specifies that the due date is based on each employee’s birthday. 

2. Next anniversary of certification date. Specifies that the due date based on the upcoming 
anniversary of the certification date of each employee. 

3. Specific date. Allows you to select a specific day from a calendar for the due date, or you can 
type the due date. 

NOTE: If you only type the month and year, the Employee Management system uses the first of the 
month as the default value. 

4.  License expiration. Specifies that the due date will occur when each employee’s current 
license expires. 

Required hours. Allows you to type in the number of hours that are required for the task (for 
example, a training class).  

 

 T.O.M Tip 

What are required hours? 

Required hours is the amount of time that a task requires before it is considered to be 
complete. Most reminders that have required hours are usually training requirement 
reminders. You will learn in Chapter 5 of the Getting Started section how to 
automatically apply hours to open reminders when you are entering training information 
into the Employee Management system. 

 

Comment. Allows you to type any comments you want to save with the reminder. • 
• 

• 

Available Employees. Displays all employees whose records were displayed on the Employees 
screen. 
Selected Employees. Displays the employees you selected for inclusion in the group reminder. 
You can use the Add, Remove, Add All and Remove All buttons to add employees to the Selected 
Employees List. 

 

Viewing an Employee’s Reminders 
1. Click the Employees tab. The Employee Management system displays the Employees screen. 

2. Click the Reset button to clear the screen. The Employee Management system clears the screen  
( ). Figure 2-15
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Click Reset to 
clear the 
screen. 

Click Find 
Now to search 
for and retrieve 
records. 

Click Group 
Training to add 
a group 
reminder to the 
system. 

 

Figure 2-15. Clearing the Employee screen 

3. Select the fields you want to use to select employee records. For example, you can type the first few 
letters of the employee’s last name if you want to search for employee records using this field 
( ). Figure 2-16
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Example 
showing a 
partial last 
name being 
used to search
employee 
records. 
 

Figure 2-16. Example of using a partial last name as the search criteria 

Figure 2-16

4. Click the Find Now button to retrieve all the employee records that match your selected criteria. 

5. Either: 

Select the employee whose reminders you want to view, and click the Edit button ( ). • 

• 
OR 

Double-click the employee’s record. 
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Figure 2-17. Selecting employee records and viewing their reminders /task

The Employee Management system displays the employee’s record. 

 

Figure 2-18. Selecting the Reminder tab in the Employee screen 
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Select the 
employee 
record, and 
then click Edit.
You can also 
double-click 
the employee 
name. 
 

s 
Click the 
Reminders tab 
to view 
reminders 
associated with
this employee. 
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6. Click the Reminders tab. The Employee Management system displays any reminders associated with 
the selected employee. 

 

Figure 2-19. Viewing an employee's reminders 

7. Either: 

Select search or sort options as described in the next section. • 

• 

• 
• 

• 

• 

• 

OR 
Click the OK or Exit button to close the screen. 

Searching and Sorting an Employee’s Reminders 
When you are viewing an employee’s reminders, you can select the following options to customize your 
view of an employee’s reminders: 

Overdue. Allows you to view employee reminder records that are past their due date.  
Due Within Warning Period. Allows you to view only those tasks that are due within the 
warning period. 
Due within X (days). Allows you to view the records that are due within the number of days you 
specify by typing in the value or by clicking the up and down areas to change the displayed value. 
All Pending. Allow s you to view all employee reminder records that have not been marked as 
complete. 
All. Allows you to view all employee reminder records in the database, including those that have 
been marked completed. 
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Only Type. Allows you to select the reminder type you want to view.  • 
• Category. Allows you to select the reminder category you want to view.  

NOTE: You can add categories and tasks to the Employee Management system by selecting 
File>Reminders. This is discussed in Chapter 5 of the Getting Started section. 

You can also sort employee tasks and reminders by Category, Type, Due Date, or Complete Date. You can 
select up to three of these options as your sort criteria. Also, after you select a sort option, you can select 
ascending or descending as the sort order. 

 

 T.O.M Tip 

What if I want to search for but not sort the records? 

You do not have to search for and sort the records. You can search for  or sort them. 

 

To search and sort an employee’s reminder records: 

1. Repeat the steps listed in the previous section for viewing an employee’s reminders. 

2.  To search an employee’s reminder records: 

Select a status option. • 
• 
• 

• 

• 
• 
• 
• 
• 
• 

Select a reminder category. 
Select a reminder type. 

OR 
Select any combination of these options.  

3. To sort an employee’s reminder records, select sorting criteria and order options by clicking the pull-
down menus and selecting options in the pull-down lists. You can sort the data up to three times. 

4. Click the OK or Exit button to close the screen. 

Scheduling a Reminder for an Employee 
You can schedule a task for an individual employee rather than a group of employees. When you create a 
new reminder for an employee, you can also specify the number of hours required for the reminder and add 
up to three attachments as well as comments to the reminder. However, if you need to create a reminder for 
a large number of employees, it is easier and more efficient to schedule a group reminder. 

This section includes the following: 

Adding a Reminder for an Individual Employee 
Understanding the Employee Reminders Screen 
Editing Employee Reminders 
Marking Reminders Complete 
Adding Attachments to Reminders 
Viewing and Clearing Attachments 
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Adding a Reminder for an Individual Employee 

1. Select an employee record on the Employees tab by double-clicking on it or by selecting it and then 
clicking Edit. The Employee Management system displays the employee’s record. 

2. Click the Reminders tab. 

3. Click the Add button. The Employee Management system displays the Reminders screen (see 
). Figure 2-20

Figure 2-20. Adding a new employee reminder 

Click Add to 
create a new 
employee 
reminder. 

 

4. Select or type information into the fields. For a detailed description of each field, see the next section. 

Figure 2-21 shows adding a reminder for an individual employee: 
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You must 
select a 
Category and 
Type; these are 
required fields. 

Click OK to 
save the 
reminder.  

Click Exit to 
close the 
screen without 
saving the 
reminder. 

Figure 2-21. Adding a reminder to an employee's record 

5. Click the OK button to save the reminder. The Employee Management system closes the screen and 
updates the Reminders screen to display the reminder you just added. 

Understanding the Employee Reminders Screen 

The Employee Management software allows you to setup both Reminder Categories and Reminder Types. 
These two reminder classifications are interrelated to each other. Reminder Category is the broad reminder 
classification, and Reminder Type is a subset of the reminder category. For example, you could have a 
Reminder Category of Training and three Reminder Types, or reminder subsets, attached to that category 
(Behind the Wheel, Classroom, and Other).  

Consequently, the Employee Management software doesn’t allow you to specify a Reminder Type until 
you have selected a Reminder Category. After you have selected the Reminder Category, the Employee 
Management system dynamically builds a list of Reminder Types that are assigned to the selected 
Reminder Category and lets you pick from those types. Using the example above, if you pick Training as 
the Reminder Category, the Employee Management system displays Behind the Wheel, Classroom, and 
Other as the Reminder Types. 

When you schedule a reminder for an employee, you can set the following options: 

Category. Allows you to select the reminder category you want to view.  • 
• 
• 

Type. Allows you to select the reminder type you want to view.  
Due Date. Allows you to select a specific day from a calendar for the due date. You can also type 
the due date, but if you only type the month and year, the Employee Management system uses the 
first of the month as the default value. 
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Complete Date. Allows you to select a specific day from a calendar for the date the task was 
completed. You can also type the complete date, but if you only type the month and year, the 
Employee Management system uses the first of the month as the default value. 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Completed. When selected, indicates the task has been completed. See the 
 section for more information about this feature. 

Marking Reminders 
Complete

Marking Reminders Complete 

NOTE: Complete Date and the Completed checkbox are both required if you complete either of these 
fields. 

Hours. Allows you to type in the number of hours required by the task (Required) as well as the 
number of hours that have been completed (Achieved). 
Attachments. Allows you to attach a document to the reminder. For information about using this 
feature, see the detailed discussion on adding attachments in the next section. See the 

 and  sections later in this chapter 
for more information about this feature. 

Adding 
Attachments to Reminders Viewing and Clearing Attachments

Comments. Allows you to type any comments you want to save with the task. 

1. Either: 

Select the reminder you want to edit, and click the Edit button. 
OR 

Double-click the employee’s reminder. 

The Employee Management system displays the Reminders screen. 

2. To mark the task as completed: 

Click the Complete Date pull-down menu. The Employee Management system displays a calendar 
so you can select a date.  

OR 
Type the complete date into the box. If you only type the month and year, the Employee 
Management system uses the first of the month as the default value. 

3. Click in the Complete box to mark the reminder as completed. 

4. Type the number of hours achieved. 

5. Click OK to save the changes. 

Figure 2-22 shows an example of a reminder that has been marked complete: 
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Figure 2-22. Sample of marking a reminder complete 

Adding Attachments to Reminders 

What are attachments? 

Many times it is helpful to include with a reminder an attached document that gives the user more 
information about this reminder (for example, a class agenda, state requirements, or a photograph). The 
T.O.M. Employee Management software has the capability. 

Attachments are nothing more than links or pointers to another document on the computer that is 
considered relevant to the employee reminders (for example, a medical report on a medical reminder). By 
allowing you to “attach” these documents to a reminder, the T.O.M. Employee Management software 
makes it easy for you to quickly open one of these associated documents while viewing the Employee 
Reminder. 

Warning notes about attachments: 

Because attachments are nothing more than links to document files you must be aware of two points: 

1.  Make sure that the actual document file is in a location that all Employee Management users that will 
work with reminders can access the file. If you add an attachment to a document that is on your 
personal computer and another user tries to open that link but doesn’t have access to that file, that user 
will receive an error message. 

2.  If you attach a document file to a reminder that requires a special program to open (such as an Adobe 
Photoshop) that a user does not have, that user will receive an error if he tries to open that attached file 
from his computer. 

T.O.M. Employee Management Manual  2-23 



 

 

Chapter 2: Working with Employee Reminder Records 

To add an attachment to the reminder: 

1. Either: 

Select the reminder you want to edit, and click the Edit button. • 

• 
OR 

Double-click the employee’s reminder. 

The Employee Management system displays the Reminders screen. 

2. Click the Browse button ( ). Figure 2-23

Figure 2-23. Adding an attachment to a reminder 

Click Browse 
to navigate to 
the file you 
want to attach 
to the 
reminder. 

 

3. Navigate to where the document is stored, select it, and click Open.  
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Select the 
attachment, 
and click 
Open. 

Figure 2-24. Selecting an attachment 

The Employee Management system adds the attachment to the reminder. You can add up to three 
attachments to the reminder ( ).  Figure 2-25

Figure 2-25. Adding an attachment to an employee's record 

An attachment 
has been added 
to the 
reminder.  

 

4. Click the OK button to save the reminder. The Employee Management system adds the attachment to 
the reminder. 
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Viewing and Clearing Attachments 

To view attachments, follow these steps: 

1. Either: 

Select the reminder you want to edit, and click the Edit button. • 

• 
OR 

Double-click the employee’s reminder. 

The Employee Management system displays the Reminders screen. 
 

2. Click on the attachment you want to view ( ).  Figure 2-26

Figure 2-26. Viewing an attachment 

gure 2-26

Click on the 
attachment to 
view it.  

Remember, 
you need to 
have the 
appropriate 
software to 
open files. For 
example, this is 
a PDF file, so 
you need 
Adobe Reader 
installed on 
your computer 
to view this 
file. 

 

The attachment in Fi  is a PDF file which is viewable in Adobe Reader. Notice how the PDF 
file is viewed in that software ( ) and not within the Employee Management system. 
Because attachments are viewed outside the Employee Management system, you need to have the 
software required by the file type. If you do not have the appropriate program to open the attachment, 
you will not be able to view it. 

Figure 2-27

Also notice that the file has been added from the c: drive. Only those who have access to the c: drive 
will be able to access the file. 
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Figure 2-27. Viewing a PDF attachment in Adobe Reader 

To clear attachments: 

1. Either: 

Select the reminder you want to edit, and click the Edit button. • 

• 
OR 

Double-click the employee’s reminder. 

The Employee Management system displays the Reminders screen. 

2. Click the Clear button to remove the attachment from the reminder. 
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Click Clear to 
remove the 
attachment 
from the 
reminder. 

Figure 2-28. Clearing an attachment 

3. Click the OK button to save your changes and close the screen. 

Editing Employee Reminders 
After you add a reminder to the Employee Management system, you can easily edit it. For example, one 
common editing task you need to do is to mark the reminder as completed. When you mark a reminder as 
completed, it will no longer appear by default in the Reminders screen when you open the Employee 
Management system. 

The procedure below describes specifically how to mark an employee reminder as complete. However, if 
you want to edit the reminder for other reasons, the same basic steps for accessing the record and updating 
it are the same as those described below. 
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To edit a reminder: 

1. Either: 

Select the reminder you want to edit, and click the Edit button. • 

• 
OR 

Double-click the employee’s reminder. 

The Employee Management system displays the Reminders screen. 

2. Make your changes to the reminder. 

3. Click OK to save your changes. 

Generating and Printing Reminder Reports 
You can generate and print several types of reminder reports for an employee or a group of employees by 
clicking the Print button. When you click the Print button, the Employee Management system displays a 
dialog that allows you to select the type of reminder report you want to generate and to type in its title. 

 

Click the Print 
button to 
generate and 
print a group 
reminder 
report. 

NOTE: For more information about generating and printing reminder reports, see Chapter 13 of the 
Users section. 
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Deleting Reminders 
You can easily delete an employee’s reminder from the Employee Management system. 

1. Select an employee record on the Employees tab by double-clicking on it or by selecting it and then 
clicking Edit. The Employee Management system displays the employee’s record. 

2. Click the Reminders tab. 

3. Select the Reminder you want to delete. 

4. Click Delete. The Employee Management system displays a dialog asking if you want to delete the 
reminder. 

 

Select the 
reminder you 
want to delete, 
and click the 
Delete button. 

Figure 2-29. Deleting reminders 

5. Click the OK button. The Employee Management system deletes the reminder from the employee’s 
record. 

Automatic Features of T.O.M. Employee Reminders 
There are two ways you can set up the Employee Management system to automatically handle employee 
reminders: 

Using Training Hours to Automatically Closing Reminders • 
• Setting up a Reoccuring Reminder 
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Using Training Hours to Automatically Closing Reminders  

When you are entering training information to an employee’s record, you have the option of having the 
Employee Management system automatically apply those hours to the employee’s open training reminder. 
This not only saves you time—it also means that you do not have to access a different area of the 
application to reenter the same data. 

NOTE: For more information about using this feature, see Chapter 4 of the User’s Guide section. 

The screen you will see when you are entering training information looks like: 

 

Click here to 
automatically 
apply training 
hours to open 
reminders. 

Figure 2-30. Automatically applying training hours to reminders 

Setting up a Reoccuring Reminder 

When you set up a reminder type, you can specify that the Employee Management system automatically re-
schedules the reminder based on its completion, when it is due, or whichever of these events occurs first.  

NOTE: You can set up a reoccurring reminder when you set up a Reminder type. This is discussed in 
detail in Chapter 5 of the Getting Started section.  

The screen you will see when setting up reoccurring reminders looks like: 
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Options you 
can set for 
reoccurring 
reminders. See 
Chapter 5 in 
the Getting 
Started section 
for more 
information 
about this 
feature. 

Figure 2-31. Automatically scheduling reminders 
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